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 Important Information

Warranty
The PXI-5660 RF Signal Analzer is warranted against defects in materials and workmanship for a period of one year from the date of shipment, 
as evidenced by receipts or other documentation. National Instruments will, at its option, repair or replace equipment that proves to be defective 
during the warranty period. This warranty includes parts and labor. 

The media on which you receive National Instruments software are warranted not to fail to execute programming instructions, due to defects 
in materials and workmanship, for a period of 90 days from date of shipment, as evidenced by receipts or other documentation. National 
Instruments will, at its option, repair or replace software media that do not execute programming instructions if National Instruments receives 
notice of such defects during the warranty period. National Instruments does not warrant that the operation of the software shall be 
uninterrupted or error free.

A Return Material Authorization (RMA) number must be obtained from the factory and clearly marked on the outside of the package before 
any equipment will be accepted for warranty work. National Instruments will pay the shipping costs of returning to the owner parts which are 
covered by warranty.

National Instruments believes that the information in this document is accurate. The document has been carefully reviewed for technical 
accuracy. In the event that technical or typographical errors exist, National Instruments reserves the right to make changes to subsequent 
editions of this document without prior notice to holders of this edition. The reader should consult National Instruments if errors are suspected. 
In no event shall National Instruments be liable for any damages arising out of or related to this document or the information contained in it.

EXCEPT AS SPECIFIED HEREIN, NATIONAL INSTRUMENTS MAKES NO WARRANTIES, EXPRESS OR IMPLIED, AND SPECIFICALLY DISCLAIMS ANY WARRANTY OF 
MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE. CUSTOMER’S RIGHT TO RECOVER DAMAGES CAUSED BY FAULT OR NEGLIGENCE ON THE PART OF 
NATIONAL INSTRUMENTS SHALL BE LIMITED TO THE AMOUNT THERETOFORE PAID BY THE CUSTOMER. NATIONAL INSTRUMENTS WILL NOT BE LIABLE FOR 
DAMAGES RESULTING FROM LOSS OF DATA, PROFITS, USE OF PRODUCTS, OR INCIDENTAL OR CONSEQUENTIAL DAMAGES, EVEN IF ADVISED OF THE POSSIBILITY 
THEREOF. This limitation of the liability of National Instruments will apply regardless of the form of action, whether in contract or tort, including 
negligence. Any action against National Instruments must be brought within one year after the cause of action accrues. National Instruments 
shall not be liable for any delay in performance due to causes beyond its reasonable control. The warranty provided herein does not cover 
damages, defects, malfunctions, or service failures caused by owner’s failure to follow the National Instruments installation, operation, or 
maintenance instructions; owner’s modification of the product; owner’s abuse, misuse, or negligent acts; and power failure or surges, fire, 
flood, accident, actions of third parties, or other events outside reasonable control.

Copyright
Under the copyright laws, this publication may not be reproduced or transmitted in any form, electronic or mechanical, including photocopying, 
recording, storing in an information retrieval system, or translating, in whole or in part, without the prior written consent of National 
Instruments Corporation.

Trademarks
CVI™, LabVIEW™, National Instruments™, NI™, and ni.com™ are trademarks of National Instruments Corporation.

Product and company names mentioned herein are trademarks or trade names of their respective companies. 

Patents
For patents covering National Instruments products, refer to the appropriate location: Help»Patents in your software, the patents.txt file 
on your CD, or ni.com/patents.

WARNING REGARDING USE OF NATIONAL INSTRUMENTS PRODUCTS
(1) NATIONAL INSTRUMENTS PRODUCTS ARE NOT DESIGNED WITH COMPONENTS AND TESTING FOR A LEVEL OF 
RELIABILITY SUITABLE FOR USE IN OR IN CONNECTION WITH SURGICAL IMPLANTS OR AS CRITICAL COMPONENTS IN 
ANY LIFE SUPPORT SYSTEMS WHOSE FAILURE TO PERFORM CAN REASONABLY BE EXPECTED TO CAUSE SIGNIFICANT 
INJURY TO A HUMAN.

(2) IN ANY APPLICATION, INCLUDING THE ABOVE, RELIABILITY OF OPERATION OF THE SOFTWARE PRODUCTS CAN BE 
IMPAIRED BY ADVERSE FACTORS, INCLUDING BUT NOT LIMITED TO FLUCTUATIONS IN ELECTRICAL POWER SUPPLY, 
COMPUTER HARDWARE MALFUNCTIONS, COMPUTER OPERATING SYSTEM SOFTWARE FITNESS, FITNESS OF COMPILERS 
AND DEVELOPMENT SOFTWARE USED TO DEVELOP AN APPLICATION, INSTALLATION ERRORS, SOFTWARE AND 
HARDWARE COMPATIBILITY PROBLEMS, MALFUNCTIONS OR FAILURES OF ELECTRONIC MONITORING OR CONTROL 
DEVICES, TRANSIENT FAILURES OF ELECTRONIC SYSTEMS (HARDWARE AND/OR SOFTWARE), UNANTICIPATED USES OR 
MISUSES, OR ERRORS ON THE PART OF THE USER OR APPLICATIONS DESIGNER (ADVERSE FACTORS SUCH AS THESE ARE 
HEREAFTER COLLECTIVELY TERMED “SYSTEM FAILURES”). ANY APPLICATION WHERE A SYSTEM FAILURE WOULD 
CREATE A RISK OF HARM TO PROPERTY OR PERSONS (INCLUDING THE RISK OF BODILY INJURY AND DEATH) SHOULD 
NOT BE RELIANT SOLELY UPON ONE FORM OF ELECTRONIC SYSTEM DUE TO THE RISK OF SYSTEM FAILURE. TO AVOID 
DAMAGE, INJURY, OR DEATH, THE USER OR APPLICATION DESIGNER MUST TAKE REASONABLY PRUDENT STEPS TO 
PROTECT AGAINST SYSTEM FAILURES, INCLUDING BUT NOT LIMITED TO BACK-UP OR SHUT DOWN MECHANISMS. 
BECAUSE EACH END-USER SYSTEM IS CUSTOMIZED AND DIFFERS FROM NATIONAL INSTRUMENTS' TESTING 
PLATFORMS AND BECAUSE A USER OR APPLICATION DESIGNER MAY USE NATIONAL INSTRUMENTS PRODUCTS IN 
COMBINATION WITH OTHER PRODUCTS IN A MANNER NOT EVALUATED OR CONTEMPLATED BY NATIONAL 
INSTRUMENTS, THE USER OR APPLICATION DESIGNER IS ULTIMATELY RESPONSIBLE FOR VERIFYING AND VALIDATING 
THE SUITABILITY OF NATIONAL INSTRUMENTS PRODUCTS WHENEVER NATIONAL INSTRUMENTS PRODUCTS ARE 
INCORPORATED IN A SYSTEM OR APPLICATION, INCLUDING, WITHOUT LIMITATION, THE APPROPRIATE DESIGN, 
PROCESS AND SAFETY LEVEL OF SUCH SYSTEM OR APPLICATION.



 Compliance

FCC/Canada Radio Frequency Interference Compliance*

Determining FCC Class
The Federal Communications Commission (FCC) has rules to protect wireless communications from interference. The FCC 
places digital electronics into two classes. These classes are known as Class A (for use in industrial-commercial locations only) 
or Class B (for use in residential or commercial locations). Depending on where it is operated, this product could be subject to 
restrictions in the FCC rules. (In Canada, the Department of Communications (DOC), of Industry Canada, regulates wireless 
interference in much the same way.)
Digital electronics emit weak signals during normal operation that can affect radio, television, or other wireless products. By 
examining the product you purchased, you can determine the FCC Class and therefore which of the two FCC/DOC Warnings 
apply in the following sections. (Some products may not be labeled at all for FCC; if so, the reader should then assume these are 
Class A devices.)
FCC Class A products only display a simple warning statement of one paragraph in length regarding interference and undesired 
operation. Most of our products are FCC Class A. The FCC rules have restrictions regarding the locations where FCC Class A 
products can be operated.
FCC Class B products display either a FCC ID code, starting with the letters EXN, 
or the FCC Class B compliance mark that appears as shown here on the right.
Consult the FCC Web site at http://www.fcc.gov for more information.

FCC/DOC Warnings
This equipment generates and uses radio frequency energy and, if not installed and used in strict accordance with the instructions 
in this manual and the CE Mark Declaration of Conformity**, may cause interference to radio and television reception. 
Classification requirements are the same for the Federal Communications Commission (FCC) and the Canadian Department 
of Communications (DOC). 
Changes or modifications not expressly approved by National Instruments could void the user’s authority to operate the 
equipment under the FCC Rules.

Class A
Federal Communications Commission
This equipment has been tested and found to comply with the limits for a Class A digital device, pursuant to part 15 of the FCC 
Rules. These limits are designed to provide reasonable protection against harmful interference when the equipment is operated 
in a commercial environment. This equipment generates, uses, and can radiate radio frequency energy and, if not installed and 
used in accordance with the instruction manual, may cause harmful interference to radio communications. Operation of this 
equipment in a residential area is likely to cause harmful interference in which case the user will be required to correct 
the interference at his own expense.

Canadian Department of Communications
This Class A digital apparatus meets all requirements of the Canadian Interference-Causing Equipment Regulations.
Cet appareil numérique de la classe A respecte toutes les exigences du Règlement sur le matériel brouilleur du Canada.

Class B
Federal Communications Commission
This equipment has been tested and found to comply with the limits for a Class B digital device, pursuant to part 15 of the 
FCC Rules. These limits are designed to provide reasonable protection against harmful interference in a residential installation. 
This equipment generates, uses, and can radiate radio frequency energy and, if not installed and used in accordance with the 
instructions, may cause harmful interference to radio communications. However, there is no guarantee that interference will not 
occur in a particular installation. If this equipment does cause harmful interference to radio or television reception, which can 
be determined by turning the equipment off and on, the user is encouraged to try to correct the interference by one or more of 
the following measures:
• Reorient or relocate the receiving antenna.
• Increase the separation between the equipment and receiver.
• Connect the equipment into an outlet on a circuit different from that to which the receiver is connected.
• Consult the dealer or an experienced radio/TV technician for help.



Canadian Department of Communications
This Class B digital apparatus meets all requirements of the Canadian Interference-Causing Equipment Regulations.
Cet appareil numérique de la classe B respecte toutes les exigences du Règlement sur le matériel brouilleur du Canada.

Compliance to EU Directives
Readers in the European Union (EU) must refer to the Manufacturer’s Declaration of Conformity (DoC) for information** 
pertaining to the CE Mark compliance scheme. The Manufacturer includes a DoC for most every hardware product except for 
those bought for OEMs, if also available from an original manufacturer that also markets in the EU, or where compliance is not 
required as for electrically benign apparatus or cables.
To obtain the DoC for this product, click Declaration of Conformity at ni.com/hardref.nsf/. This Web site lists the DoCs 
by product family. Select the appropriate product family, followed by your product, and a link to the DoC appears in Adobe 
Acrobat format. Click the Acrobat icon to download or read the DoC.

* Certain exemptions may apply in the USA, see FCC Rules §15.103 Exempted devices, and §15.105(c). Also available in 
sections of CFR 47.

** The CE Mark Declaration of Conformity will contain important supplementary information and instructions for the user or 
installer.



Conventions

The following conventions are used in this guide: 

< > Angle brackets that contain numbers separated by an ellipsis represent a 
range of values associated with a bit or signal name—for example, 
DBIO<3..0>.

» The » symbol leads you through nested menu items and dialog box options 
to a final action. The sequence File»Page Setup»Options directs you to 
pull down the File menu, select the Page Setup item, and select Options 
from the last dialog box.

This icon denotes a tip, which alerts you to advisory information.

This icon denotes a note, which alerts you to important information.

ADC Analog-to-Digital Converter—an electronic device, often an integrated 
circuit, that converts an analog voltage to digital data

bold Bold text denotes items that you must select or click on in the software, 
such as menu items and dialog box options. 

coupling The manner in which a signal is connected from one location to another. 
AC coupling removes the DC component from a signal.

dBc Decibels (dB) relative to carrier signal frequency

downconverter The PXI-5600 RF downconverter module. A downconverter “zooms in” on 
a narrow frequency component of a signal and shifts it to center around a 
lower frequency, 15 MHz in the case of the PXI-5600.

IF Intermediate Frequency—The intermediate signal to which an RF signal is 
converted in order to be demodulated, displayed, or processed. For 
instance, the PXI-5600 downconverter will convert RF signals to a 15 MHz 
IF signal that can be digitized.

italic Italic text denotes variables, emphasis, a cross reference, or an introduction 
to a key concept. This font also denotes text that is a placeholder for a word 
or value that you must supply.



monospace Text in this font denotes text or characters that you should enter from the 
keyboard, programming examples, and syntax examples. This font is also 
used for paths, directories, programs, subprograms, subroutines, device 
names, functions, filenames and extensions.

resolution bandwidth Resolution bandwidth determines how closely spaced in frequency two 
signals of equal amplitude can be and still be distinguishable from each 
other. When measuring a frequency spectrum, decreasing the resolution 
bandwidth results in finer frequency resolution and increasing the 
resolution bandwidth results in coarser frequency resolution.

RF Radio Frequency—Though there is no precise definition, the term is often 
used for frequencies from tens of megahertz to several gigahertz.

RFSA RF Signal Analyzer—In this document, RFSA refers to the PXI-5660, 
which consists of a PXI-5600 RF downconverter module and a PXI-5620 
frequency-domain digitizer module. 
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1
Set Up and Configuration

Required Equipment
To set up and use the National Instruments PXI-5660 RF Signal Analyzer 
(RFSA), you need the following items:

❑ Both PXI-5660 RFSA modules:

– PXI-5600 9 kHz to 2.7 GHz wideband RF downconverter module

– PXI-5620 14-bit, 64 MS/s frequency-domain digitizer module

❑ RF Signal Analyzer CD containing the NI-SCOPE and 
NI-TUNER drivers

❑ NI Spectral Measurements Toolset (SMT) CD

❑ Cables and accessories:

– Two rigid coaxial cables

– One semi-rigid coaxial cable

– Two “finger-saver” cable wrenches

Related Documentation
In addition to this manual, you may find the following documents helpful:

• The NI-TUNER Reference Help File contains function and VI 
reference information for LabVIEW, LabWindows/CVI, and 
C programers. The help file is installed at Start»Programs»
National Instruments»RF Signal Analyzer»Documentation»
Low Level»NI-TUNER Reference Help.

• The online Spectral Measurements Toolset User Guide contains 
information on configuring and using the SMT with your PXI-5660 
RF Signal Analyzer. It is located at Start»Programs»National 
Instruments»RF Signal Analyzer»Documentation»Spectral 
Measurements Toolset User Guide.pdf.

• The NI-SCOPE Function Reference Help file provides detailed 
explanations of NI-SCOPE functions, attributes, and parameters for 
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LabWindows/CVI, C, and Visual Basic programmers. The help file 
is located at Start»Programs»National Instruments»RF Signal 
Analyzer»Documentation»Low Level»NI-SCOPE Function 
Reference Help.

• The NI-SCOPE VI Reference Help file provides detailed explanations 
of NI-SCOPE VIs, properties, and parameters for LabVIEW. The help 
file is located at Start»Programs»National Instruments»RF Signal 
Analyzer»Documentation»Low Level»NI-SCOPE VI Reference 
Help.

• The printed PXI-5620 Digitizer User Manual is packaged with your 
PXI-5620 digitizer module.

Unpacking
Both modules of the PXI-5660 RF Signal Analyzer ship in antistatic 
packages to prevent electrostatic damage. Electrostatic discharge can 
damage several components of the RFSA.

To protect yourself and your device, take all of the following precautions 
when unpacking the two RFSA modules:

• Ground yourself by touching a grounded object.

• Touch the antistatic package to a metal part of the PXI chassis before 
removing the module from the package.

• Remove each module from the package and inspect it for loose 
components or any other sign of damage. Notify NI if any component 
of the RFSA appears damaged in any way. Do not install 
damaged hardware.

• Never touch the exposed connector pins.

• Store both RFSA modules in the antistatic envelopes when not in use.

Safety Information
The following section contains important safety information that you must 
follow when installing and using the product.

Do not operate the product in a manner not specified in this document. 
Misuse of the product can result in a hazard. You can compromise the 
safety protection built into the product if the product is damaged in any 
way. If the product is damaged, return it to National Instruments for repair.



Chapter 1 Set Up and Configuration

© National Instruments Corporation 1-3 PXI-5660 RF Signal Analyzer User Manual

Do not substitute parts or modify the product except as described in this 
document. Use the product only with the chassis, modules, accessories, and 
cables specified in the installation instructions. You must have all covers 
and filler panels installed during operation of the product.

Do not operate the product in an explosive atmosphere or where there may 
be flammable gases or fumes. Operate the product only at or below the 
pollution degree stated in the Specifications for the PXI-5660 RF Signal 
Analyzer Note to Users. Pollution is foreign matter in a solid, liquid, or 
gaseous state that can reduce dielectric strength or surface resistivity. The 
following is a description of pollution degrees:

• Pollution degree 1 means no pollution or only dry, nonconductive 
pollution occurs. The pollution has no influence.

• Pollution degree 2 means that only nonconductive pollution occurs in 
most cases. Occasionally, however, a temporary conductivity caused 
by condensation must be expected.

• Pollution degree 3 means that conductive pollution occurs, or dry, 
nonconductive pollution occurs that becomes conductive due to 
condensation.

Clean the product with a soft nonmetallic brush. Make sure that the product 
is completely dry and free from contaminants before returning it to service.

You must insulate signal connections for the maximum voltage for which 
the product is rated. Do not exceed the maximum ratings for the product. 
Remove power from signal lines before connecting them to or 
disconnecting them from the product.

Operate this product only at or below the installation category stated in the 
Specifications for the PXI-5660 RF Signal Analyzer Note to Users. 

The following is a description of installation categories:

• Installation category I is for measurements performed on circuits not 
directly connected to MAINS1. This category is a signal level such as 
voltages on a printed wire board (PWB) on the secondary of an 
isolation transformer. 

Examples of installation category I are measurements on circuits not 
derived from MAINS and specially protected (internal) 
MAINS-derived circuits.

1   MAINS is defined as the electricity supply system to which the equipment concerned is designed to be connected either for 
powering the equipment or for measurement purposes.
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• Installation category II is for measurements performed on circuits 
directly connected to the low-voltage installation. This category refers 
to local-level distribution such as that provided by a standard 
wall outlet.

Examples of installation category II are measurements on household 
appliances, portable tools, and similar equipment.

• Installation category III is for measurements performed in the building 
installation. This category is a distribution level referring to hardwired 
equipment that does not rely on standard building insulation.

Examples of installation category III include measurements on 
distribution circuits and circuit breakers. Other examples of 
installation category III are wiring including cables, bus-bars, junction 
boxes, switches, socket outlets in the building/fixed installation, and 
equipment for industrial use, such as stationary motors with a 
permanent connection to the building/fixed installation.

• Installation category IV is for measurements performed at the source 
of the low-voltage (<1,000 V) installation.

Examples of category IV are electric meters and measurements on primary 
overcurrent protection devices and ripple-control units. Below is a diagram 
of a sample installation.



Chapter 1 Set Up and Configuration

© National Instruments Corporation 1-5 PXI-5660 RF Signal Analyzer User Manual

Installation
The PXI-5660 RF Signal Analyzer consists of the following hardware 
modules and software components:

❑ NI-SCOPE and NI-TUNER drivers, contained on the included 
RF Signal Analyzer software CD

❑ NI Spectral Measurements Toolset CD 

❑ PXI-5600 wideband RF downconverter module

❑ PXI-5620 RF digitizer module

Note You must install the included software before installing your hardware.

The NI-SCOPE and NI-TUNER drivers run the RFSA hardware modules 
and acquire data. The Spectral Measurements Toolset (SMT) provides 
versatile spectral measurement and analysis functionality as well as 
example programs. The relationship between the PXI-5660 RF Signal 
Analyzer components is illustrated in Figure 1-1. 

Figure 1-1.  Programming Flow

User Application
(LabVIEW, C)

SMT

NI-TUNER

PXI-5600

NI-SCOPE

PXI-5620
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Software Installation
Complete the following steps to install the included RF Signal Analyzer 
software:

1. Insert the RF Signal Analyzer software CD. The installation program 
begins automatically. If it does not, navigate to your CD drive and 
double-click Setup.exe to begin installing the RFSA drivers. 

2. Select one of the following installation options:

• Typical—this option installs required software components not 
present on your system and updates past installations of NI 
software to work with the PXI-5660 RF Signal Analyzer.

• Complete—this option installs all RF Signal Analyzer software 
components and overwrites old installations. Use this option 
for highest performance or if you are unsure of which software 
components you need. 

• Custom—this option prompts you before installing each 
individual software component. 

3. When prompted by the installation program, insert the Spectral 
Measurements Toolset CD and click Next to resume installation. 

Hardware Installation

Note You must install the included software before installing the hardware.

1. Power off the PXI chassis.

2. Install your PXI-5600 RF downconverter module as shown in 
Figure 1-2.

a. Remove the black plastic protectors from the six screws in the 
downconverter module front panel.

b. Slide the RF downconverter module into an available PXI slot 
until the ejector handle locks in the upward position.

c. Tighten the six screws on the RF downconverter module 
front panel.

Note The PXI-5600 RF downconverter module 10 MHz internal reference clock can drive 
the PXI backplane clock only if installed in slot 2. The RF downconverter module can 
receive the PXI backplane clock in any slot.



Chapter 1 Set Up and Configuration

© National Instruments Corporation 1-7 PXI-5660 RF Signal Analyzer User Manual

Figure 1-2.  PXI-5600 RF Downconverter Module Installation

3. Install the PXI-5620 frequency-domain digitizer module as shown 
in Figure 1-3.

a. Remove the black plastic protectors from the two screws in the 
digitizer module front panel.

b. Slide the digitizer module into the slot immediately right of the 
PXI-5600 downconverter. Press firmly until the ejector handle 
locks in the upward position. 

Note To use the included rigid coaxial cables, you must install the PXI-5620 digitizer 
module in the PXI slot immediately to the right of the PXI-5600 downconverter module.
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c. Tighten the two screws on the frequency-domain digitizer module 
front panel.

Figure 1-3.  PXI-5620 Frequency-Domain Digitizer Module Installation
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The RFSA Front Panels
The front panel of the RFSA contains two LEDs and nine connectors. 
The upper LED is activated when the PXI-5600 downconverter module 
is powered on. The lower LED indicates when the downconverter module 
internal oscillators are phase-locked. Refer to Table 1-1 for explanations 
of the connectors and their uses. 

All inputs and outputs are AC coupled. 

Table 1-1.  PXI-5660 RF Signal Analyzer Front Panel Connectors  

Front Panel Connector Use 

PXI-5600 RF 
downconverter module 

INPUT Attachment for the analog input signal 
measured by the RFSA.

OUTPUT Output for the frequency-translated signal.

FREQ REF IN Input for an external frequency reference 
signal to which the RFSA can lock.

10 MHz OUT Both connectors output identical 180° 
out-of-phase replications of the 
downconverter frequency reference signal, 
useful for driving other devices.

10 MHz OUT

PXI 10 MHz I/O Bidirectional connection to the PXI 
10 MHz backplane clock. 
(This connector can input to the backplane 
only if the PXI-5600 downconverter module 
is installed in slot 2.) Refer to Table 1-2 for 
more information.

PXI-5620 
frequency-domain 
digitizer module 

INPUT Attachment for the frequency-translated 
signal from the PXI-5600 downconverter 
module OUTPUT connector.

REF CLK IN Input for a 50 Ω, 10 MHz reference clock 
from the PXI-5600 downconverter module 
or another source. Normally connected to the 
PXI-5600 downconverter 10 MHz OUT 
connector. 

PFI 1 Attachment for external digital triggers.
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The PXI-5600 Internal Timebase and the PXI Backplane Clock
The internal 10 MHz timebase of the PXI-5600 downconverter module is 
the most accurate and stable NI offers, equivalent to standalone frequency 
reference products. For this reason, you may wish to use the PXI-5600 
10 MHz internal reference as a timebase for other devices. 

The PXI-5600 reference signal can be passed to other devices via the 
PXI 10 MHz backplane or through the PXI-5600 10 MHz I/O front panel 
coaxial connectors. While the PXI backplane offers less than 1 ns skew 
between slots, connections via the front panel 10 MHz I/O coaxial 
connections are more precise.

Tip For best results, drive the PXI-5600 internal reference signal to other devices via the 
PXI 10 MHz I/O coaxial connections on the downconverter module front panel.

Interconnecting
For maximum versatility, the RFSA modules interconnect through the front 
panels. Use the included coaxial cables to connect the modules as shown 
in Figure 1-4. 

Complete the following steps to interconnect the RFSA modules:

Note Install the cables so that they bend upward as in Figure 1-4. 

1. Connect the short rigid cable between the 
PXI-5600 downconverter module OUTPUT connector 
and the INPUT connector of the PXI-5620 digitizer module. 

2. Connect the long rigid cable between either of the PXI-5600 
downconverter module reference outputs (10 MHz OUT) and the 
PXI-5620 digitizer module reference clock input (REF CLK IN).

3. If you wish to drive or lock to the PXI backplane with the highly 
precise PXI-5600 internal reference (optional), connect the short 
semi-rigid cable between the other 10 MHz OUT connector and the 
PXI 10 MHz I/O connector on the PXI-5600 downconverter module 
front panel. Refer to Table 1-2 for more information about timing 
configurations and front panel connections.
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Figure 1-4.  Front Panel Connections
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4. Connect the bidirectional PXI 10 MHz I/O connector on the PXI-5600 
downconverter module front panel according to your desired timing 
configuration. Refer to Table 1-2 for more information. 

 

5. Power on your PXI chassis if you have not done so.

Note To operate the PXI-5620 frequency-domain digitizer module and the PXI-5600 
RF downconverter module as separate units, remove the relevant front panel connections. 
However, you may wish to lock the digitizer module to the downconverter module or other 
references when acquiring data. 

Table 1-2.  Timing Reference Configurations and the PXI 10 MHz I/O Connector

Timing Configuration
PXI-5600 PXI 

Installation Slot Connections

RFSA independent, PXI backplane 
independent—the default configuration 
in NI-TUNER software.

any slot No connections to 
PXI 10 MHz I/O

RFSA driving PXI backplane (shown in 
Figure 1-4)

only slot 2 10 MHz OUT to 
PXI 10 MHz I/O**

RFSA locked to PXI backplane* any slot except 2 PXI 10 MHz I/O** to 
FREQ REF IN

RFSA and PXI backplane locked to 
external reference

slot 2 External signal to 
FREQ REF IN; 10 MHz OUT 
to PXI 10 MHz I/O**

RFSA locked to external reference, PXI 
backplane independent 

any slot External signal to 
FREQ REF IN

RFSA independent, PXI backplane 
driven by external reference 

slot 2 External signal to 
PXI 10 MHz I/O**

* Use this configuration only when driving the PXI backplane with a high-precision reference (such as a PXI-6608 or 
another PXI-5600 downconverter module) installed in slot 2.

** Because the NI-TUNER default configuration does not use the PXI 10 MHz I/O connector, you must properly configure 
your software to use this connection. For more information, refer to the NI-TUNER Reference Help file, located at 
Start»Programs»National Instruments»RF Signal Analyzer»Documentation. 
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Configuring the Hardware Modules in MAX
Launch Measurement & Automation Explorer (MAX) by double-clicking 
the desktop icon or by selecting Start»Programs»National Instruments» 
Measurement & Automation.

1. MAX automatically detects new installed devices. Double-click 
Devices and Interfaces to see a list of recognized devices. If the 
PXI-5620 digitizer module and the PXI-5600 downconverter module 
do not automatically appear, refresh the list by pressing <F5>.

2. Right-click the PXI-5620 digitizer module and select Properties from 
the drop-down menu to launch the Configuring Devices window. 
Make note of the device number and system resources assigned to 
the PXI-5620 digitizer module. You need this number to program 
your device.

3. In the Configuring Devices window, click Test Resources. A dialog 
box appears and indicates if the digitizer module has passed.

4. Right-click the PXI-5600 downconverter module and select 
Properties from the drop-down menu to launch the Configuring 
Devices window. Make note of the device number and system 
resources assigned to the PXI-5600 RF downconverter module. 
You need this number to program your device.

5. In the Configuring Devices window, click Test Resources. A dialog 
box appears and indicates if the downconverter module has passed.

Note If either module does not pass, power off your PXI chassis, remove both RFSA 
hardware modules and repeat the installation procedure. If either module still does not pass 
the test, call NI or visit ni.com/support.

6. Connect a test signal to the INPUT connector on the PXI-5620 
digitizer module front panel. Click Run Test Panels to run the 
functional test panel for the PXI-5620. The PXI-5600 downconverter 
has no test panel.

Note If the PXI-5620 digitizer module cannot run the functional test, call NI or visit 
ni.com/support.

7. Click Close when you finish testing the RFSA modules. Click OK 
from the Configuring Devices window to return to the MAX main 
window.

8. Select File»Exit to exit MAX. 
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Spectral Measurements Toolset Basics
The NI Spectral Measurements Toolset (SMT) is the measurement and 
analysis software for your PXI-5660 RF Signal Analyzer. This software 
package allows easy configuration of spectral measurements and supports 
a variety of operations, including:

• Configuration functions that abstract hardware settings and return an 
acquisition size based on your spectrum settings of center frequency, 
span, and resolution bandwidth 

• 3D spectrogram display of joint-time and frequency-domain data and 
export of filtered time-domain data

• Zoom FFT processing, which computes the FFT only within a 
frequency range you specify; block zoom, which performs the FFT 
on a discrete block of data; and continuous zoom, which performs 
the FFT in real-time on incoming data, are available 

• Power in band, adjacent channel power, and occupied bandwidth 
functions suitable for communications-oriented measurements

• Spectrum averaging, including rms, vector, and peak hold averaging, 
with linear and exponential weighting

• Unit conversion for typical RF units such as V2
rms, dB, dBm, and 

dBm/Hz, allowing you to easily convert a raw FFT spectrum to a 
power spectrum or power spectral density for noise measurements

• Spectrum peak frequency and amplitude measurement

Refer to the Spectral Measurements Toolset User Guide for more 
information on using the SMT by selecting Start»Programs»
National Instruments»RF Signal Analyzer»Documentation.
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2
Making Basic Measurements

This chapter introduces some basic RFSA measurements, including 
frequency and amplitude, channel power, harmonics, and signal resolution. 
The interactive RF Signal Analyzer Example VI demonstrates these 
measurement capabilities of the RFSA. The RF Signal Analyzer Example 
VI is located at Start»Programs»National Instruments»RF Signal 
Analyzer»RF Signal Analyzer Example VI. When the VI is running, 
press <Ctrl-H> to view information about the controls.

Tip The included SMT RBW Tutorial VI can be used to find an appropriate resolution 
bandwidth (RBW) setting given the frequency and amplitude differences between two 
tones you are trying to resolve. The SMT RBW Tutorial VI is installed in the SMT 
Simulated Examples folder located at Start»Programs»National Instruments»
RF Signal Analyzer»LabVIEW Examples»Low Level»Spectral Measurements 
Toolset.

Note Make sure that both modules of the RF Signal Analyzer are interconnected as 
shown in Figure 1-4, Front Panel Connections, before performing the measurements in 
this chapter.

Measuring Frequency and Amplitude
For this example, use the downconverter module reference from one of 
the 10 MHz OUT connectors as the source signal. Complete the following 
steps to perform a frequency and amplitude measurement using the 
RF Signal Analyzer Example VI:

1. In the PXI-5600 downconverter module front panel, connect one of 
the 10 MHz OUT reference outputs to the INPUT connector.

2. Open the RF Signal Analyzer Example VI by selecting 
Start»Programs»National Instruments»RF Signal Analyzer»
RF Signal Analyzer Example VI.

3. Notice the Hardware Settings menu at the right bottom corner of the 
RF Signal Analyzer Example VI front panel. This menu consists of 
selectable views containing spectral information such as span and 
resolution bandwidth, as well as hardware information such as trigger, 
device numbers, and attenuation. 
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Note Use the increment/decrement arrows to select views and change control settings.

a. Select the RF Settings view of the Hardware Settings menu. 
Set the center frequency to 10 MHz, the span to 10 MHz, 
and the resolution bandwidth to 10 kHz.

b. Select the Amplitude view of the Hardware Settings menu. 
Set Ref Level (dBm) to 10 dBm and check the attenuation auto 
box. Refer to Chapter 3, Guidelines for Making Accurate 
Measurements, for more information.

4. Run the RF Signal Analyzer Example VI by clicking the RUN icon on 
the toolbar (white arrow) or by pressing <Ctrl-R>. A signal appears at 
the center of the spectrum graph. 

5. Set the averaging controls located below the spectrum graph to the 
following values: 

• averaging type—rms averaging

• weighting type—linear

• size—10 averages

• linear weighting mode—moving average

6. In the Units control below the spectrum graph, select dBm. 

7. Notice the Measurements menu in the upper right corner of the 
RF Signal Analyzer Example VI front panel. This menu consists of 
several views containing measurement settings and controls.

a. Select the Peak Search view of the Measurements menu. 
A yellow peak threshold line appears on the spectrum graph.

b. Click the peak threshold line and drag it below the peak value 
of the 10 MHz signal. 

In the Peak Search view, the frequency displayed on the graph and its 
corresponding amplitude are shown in the units selected.

Resolving Two Signals Closely Spaced in Frequency
For a given portion of a displayed spectrum, the frequency resolution is 
a function of the resolution bandwidth. The displayed spectral shape of 
a pure sinusoidal waveform input is a function of the filter’s spectral 
response. The larger the resolution bandwidth of the filter, the wider its 
spectral response. Using a large resolution bandwidth setting, two closely 
spaced signals of equal amplitude appear as one signal in the displayed 
spectrum. To resolve these two signals, decrease the RFSA resolution 
bandwidth setting. 
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The resolution bandwidth determines how closely spaced in frequency 
two signals of equal amplitude can be and still be distinguishable from each 
other. By default, the RFSA resolution bandwidth is the 3 dB point of the 
filter. If the frequency separation between two input signals is the same as 
the resolution bandwidth, their spectral responses intersect at 3 dB below 
their peaks. This intersection appears as a dip in the center of these 
two peaks. 

Perform the following steps to resolve two closely spaced signals:

1. Connect two signal sources as shown in Figure 2-1.

Figure 2-1.  Closely Spaced Signal Measurement Setup

2. Connect the signal to the INPUT connector on the PXI-5600 
downconverter module front panel. 

3. Set the amplitudes of both sources to –20 dBm. Set their frequencies 
10 kHz apart: one to 99.995 MHz and the other to 100.005 MHz.

4. Open the RF Signal Analyzer Example VI by selecting Start»
Programs»National Instruments»RF Signal Analyzer»RF Signal 
Analyzer Example VI.

5. Notice the Hardware Settings menu at the right bottom corner of the 
RF Signal Analyzer Example VI front panel. This menu consists of 
selectable views containing spectral information such as span and 
resolution bandwidth, as well as hardware information such as timing 
and trigger settings, device numbers, and attenuation. 

Note Use the increment/decrement arrows to select views and change control settings.

a. Select the RF Settings view of the Hardware Settings menu. 
Set the center frequency to 100 MHz, the span to 1 MHz, and 
the resolution bandwidth to 20 kHz.
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b. In the Amplitude view of the Hardware Settings menu, set the 
Ref Level (dBm) to –20 dBm and check the attenuation auto 
box. Refer to Chapter 3, Guidelines for Making Accurate 
Measurements for further explanations of these settings and their 
effects on measurement.

6. Run the RF Signal Analyzer Example VI by clicking the RUN icon 
(white arrow) on the toolbar or by pressing <Ctrl-R>. A 100 MHz 
signal appears on the spectrum graph. 

7. Set the averaging controls located below the spectrum graph to the 
following values: 

• averaging type—rms averaging

• weighting type—linear

• size—10 averages

• linear weighting mode—moving average

8. In the Units control below the spectrum graph, select dBm. 

9. Return to the RF Settings view of the Hardware Settings menu and 
complete the following steps: 

a. Zoom in on the spectrum by setting the Span to 100 kHz. The two 
signals appear to be one signal in the spectrum.

b. Decrease the Resolution Bandwidth to 10 kHz. A dip appears in 
the center of the signal spectrum. The depth of this dip relative to 
the peaks is equal to the defined resolution bandwidth value of the 
RFSA, which is 3 dB. 

c. Decrease Resolution Bandwidth to 1 kHz. Two distinct signals 
of equal amplitude appear on the spectrum graph.

Resolving signals of unequal amplitudes may require reduction of the 
resolution bandwidth to much less than the signal separation because 
the smaller signal may be hidden in the spectral skirt of the larger signal. 

Measuring Harmonics
Complete the following steps to perform a harmonic measurement using 
the RF Signal Analyzer Example VI:

1. On the PXI-5600 downconverter front panel, connect one of the 
10 MHz OUT reference outputs to the INPUT connector.

2. Open the RF Signal Analyzer Example VI by selecting Start»
Programs»National Instruments»RF Signal Analyzer»RF Signal 
Analyzer Example VI.
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3. Notice the Hardware Settings menu at the right bottom corner of the 
RF Signal Analyzer Example VI front panel. This menu consists of 
selectable views containing spectral information such as span and 
resolution bandwidth, as well as hardware information such as timing 
and trigger settings, device numbers, and attenuation. 

Note Use the increment/decrement arrows to select views and change control settings.

a. Select the RF Settings view of the Hardware Settings menu. 
Set center frequency to 25 MHz, span to 40 MHz, and 
resolution bandwidth to 100 kHz.

b. In the Amplitude view of the Hardware Settings menu, set 
Ref Level (dBm) to 10 dBm and check the attenuation auto 
box. For further explanation of these settings and their effects 
on measurements, refer to Chapter 3, Guidelines for Making 
Accurate Measurements.

4. Run the RF Signal Analyzer Example VI by clicking the RUN icon 
(white arrow) on the toolbar or by pressing <Ctrl-R>. A signal appears 
at the center of the spectrum graph. 

5. Set the averaging controls below the spectrum graph to the 
following values: 

• averaging type—rms averaging

• weighting type—linear

• size—10 averages

• linear weighting mode—moving average

6. In the Units control below the spectrum graph, select dBm. 

7. Notice the Measurements menu in the upper right corner of the 
RF Signal Analyzer Example VI front panel. This menu consists of 
several views containing measurement settings and controls.

a. Select the Peak Search view of the Measurements menu. 
A yellow peak threshold line appears on the spectrum graph.

b. Click on the peak threshold line and drag it below the peak value 
of the 10 MHz signal and its harmonics. 

c. In the Peak Search Setting submenu of the Peak Search view, 
select Multiple Peaks.

d. Click the Select Peak button. Select the harmonic peak to read off 
its value to the fourth harmonic.
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Measuring Adjacent Channel Power
For this example, use the PXI-5600 downconverter module reference from 
one of the 10 MHz OUT connectors as the source signal. Complete the 
following steps to measure adjacent channel power leakage using the 
RF Signal Analyzer Example VI: 

1. On the PXI-5600 downconverter front panel, connect one of the 
10 MHz OUT reference outputs to the INPUT connector.

2. Open the RF Signal Analyzer Example VI by selecting Start»
Programs»National Instruments»RF Signal Analyzer»RF Signal 
Analyzer Example VI.

3. Notice the Hardware Settings menu at the right bottom corner of the 
RF Signal Analyzer Example VI front panel. This menu consists of 
selectable views containing spectral information such as span and 
resolution bandwidth, as well as hardware information such as timing 
and trigger settings, device numbers, and attenuation.

Note Use the increment/decrement arrows to select views and change control settings. 

a. Select the RF Settings view of the Hardware Spectrum Settings 
menu. Set center frequency to 10 MHz, span to 100 kHz, and 
the resolution bandwidth to 1 kHz.

b. In the Amplitude view of the Hardware Settings menu, set the 
Ref Level to 10 dBm and check the attenuation auto box. Refer 
to Chapter 3, Guidelines for Making Accurate Measurements, for 
further explanation of these settings and their effects on 
measurements.

4. Run the RF Signal Analyzer Example VI by clicking the RUN icon 
(white arrow) on the toolbar or by pressing <Ctrl-R>. A signal appears 
at the center of the spectrum graph. 

5. Set the averaging controls located below the spectrum graph to the 
following values: 

• averaging type—rms averaging

• weighting type—linear

• size—10 averages

• linear weighting mode—moving average

6. In the Units control below the spectrum graph, select dBm. 
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7. Notice the Measurements menu in the upper right corner of the 
RF Signal Analyzer Example VI front panel. This menu consists of 
several views containing measurement settings and controls.

8. Select the adjacent channel power (ACP) view of the Measurements 
menu and set the controls to the following values:

• channel center—10 MHz 

• channel bandwidth—10 kHz; this is the bandwidth of the 
channel in which signal power is measured 

• channel spacing—20 kHz; this is the frequency spacing between 
the centers of each channel

Three graphical histogram bars appear on the spectrum graph. 
The center bar shows the total power in the 10 kHz bandwidth channel. 
The two bars on each side show the upper and lower adjacent channel 
powers.
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3
Guidelines for Making Accurate 
Measurements

This chapter provides guidelines for making accurate measurements with 
the National Instruments PXI-5660 RF Signal Analyzer.

General Amplitude/Spectrum Measurement
Amplitude dynamic range is the difference between the maximum input 
level of a device and its minimum detectable signal level. This value 
estimates the ability of the PXI-5660 RFSA to distinguish and measure 
the amplitude difference of two signals. The RFSA can make signal 
measurements over a wide frequency range—from 9 kHz to
2.7 GHz—and a large amplitude dynamic range of greater than 100 dB. 

Signals of large amplitude can saturate the system and cause spurious 
effects. These “spurs” may be large enough to be mistaken for real signals. 
Avoid this effect by properly adjusting the amplitude of the incoming 
signal. Achieving proper signal levels may involve attenuating the signal 
before it gets to the first mixer, either by programming the internal 
attenuators or by using external attenuation.

The RF Signal Analyzer must be properly configured before making 
a measurement. A small signal can be buried in noise if the resolution 
bandwidth setting is too large. To measure a small signal, make sure that 
the input attenuators are switched off and lower the resolution bandwidth 
setting to reduce the noise content. For signals below the noise floor of the 
instrument, use an external low-noise amplifier (LNA) in front of the RFSA 
to raise the signal level. If the update speed is not fast enough to resolve 
a signal due to the processing demands imposed by a narrow resolution 
bandwidth, an LNA helps provided it does not significantly affect system 
linearity. For example, with a signal level of –100 dBm, set the resolution 
bandwidth to 1 kHz or less.
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Harmonic Distortion
Harmonic distortion is a measure of the amount of power contained in 
the harmonics of a fundamental signal. Harmonic distortion is inherent to 
devices and systems that possess nonlinear characteristics—the more 
nonlinear the device, the greater its harmonic distortion. 

Harmonic distortion can be expressed as a power ratio or as a percentage 
ratio. Use the following formula to express it as a power ratio: 

(dBc)

where PHD is the power of the harmonic distortion in dBc, Pfund is the 
fundamental signal power in dB or dBm, and Pharm is the power of the 
harmonic of interest in dB or dBm.

Convert the powers to voltages to express harmonic distortion as 
a percentage ratio:

Percentage of Distortion = %

In some applications, the harmonic distortion is measured as a total 
percentage harmonic distortion (THD). This measurement involves the 
power summation of all the harmonics in the spectrum band, defined in the 
following equation:

%

A typical setup to perform a harmonic distortion measurement is shown 
in Figure 3-1. A lowpass or bandpass filter passes the fundamental signal 
while suppressing its harmonics. This setup injects a very clean sinusoidal 
signal into the unit under test (UUT). Any harmonic content at the UUT 
output is assumed to be generated by the UUT instead of the source. 

PHD Pfund Pharm–=
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Figure 3-1.  Typical Harmonic Distortion Measurement Setup

Tip LabVIEW 6.0 and later provide harmonic distortion analyzer and signal, noise, 
and distortion analyzer VIs that are useful for this task.

Understanding the RFSA Harmonic Distortion Limits 
As with all signal analyzers, there are residual distortions inherent in the 
PXI-5660 RFSA. It is important that these distortions do not corrupt 
your measurement. 

The level of internal distortion is a function of the linearity of the system, 
which is primarily determined at the input mixer. Increasing input power 
at the mixer increases distortion, so if the input signal is too high, the 
internally generated harmonics overwhelm the harmonics of the 
original signal. 

The specifications for the second- and third-order harmonic intercept 
points provide sufficient information about the linearity of the system. 
For example, to measure a second-order harmonic at –70 dBc, the 
fundamental power at the mixer input has to satisfy the following 
condition:

where IIP2 is the second-order intercept point. 

If the input signal power is greater than this value, the signal must be 
attenuated before the first mixer. There is an upper limit on the amount 
of attenuation you can switch in because the noise floor rises by the same 
amount as the attenuation. To lower the noise level decrease the resolution 
bandwidth, but keep in mind that there is also a practical lower limit on the 
resolution bandwidth. Decreasing the resolution bandwidth increases 
measurement time.
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The harmonic distortion dynamic range (HDDR) indicates the minimum 
distortion the RFSA can measure, which is about –96 dBc/Hz for 
the PXI-5660.

Choosing an Optimal Setting for the RFSA
Because the level of harmonic distortion is often unknown, the optimal 
attenuation level can be difficult to determine. Complete the following 
steps to find the proper attenuation setting for the RFSA: 

1. Set the attenuation so that the input power at the mixer is about 
–30 dBm. When using the RF Signal Analyzer Example VI, 
mixer level is the reference level minus attenuation. 

2. Tune to the harmonic frequency of interest and then decrease 
the resolution bandwidth until the harmonic spur appears.

3. Increase the attenuation level. If the harmonic spur decreases, 
attenuate more. 

4. Repeat step 3 until the harmonic level does not decrease any further. 
Attenuation does not lower the harmonics of the original signal; it only 
lowers the internally generated ones. 

5. Decrease the resolution bandwidth to lower the noise floor.

This setting is the optimal attenuation setting.

Two-Tone Third-Order Intermodulation Distortion 
Two-tone third-order intermodulation distortion (IMD3) is the measure of 
the third-order distortion products produced by a nonlinear device when 
two tones closely spaced in frequency are fed into its input. This distortion 
product is usually so close to the carrier that it is almost impossible to filter 
out and can cause interference in multichannel communications equipment. 

If F1 and F2 are the frequencies of the two tones, then the third-order 
distortion products occur on both sides of these tones at and 

. Assuming that the power levels of the two tones are equal, IMD3 
is the difference between the power of the fundamental signals and the 
third-order products, as defined in the following equation:

where o refers to the output of the UUT, Po3 is the power level of one of 
the output third-order products, and Po is the power level of one of the 
fundamental tones. 

122 FF −
212 FF −

33 oo PPIMD −=
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The math becomes more involved if the powers of the two tones are 
different. Once the IMD3 is measured, calculate the UUT output 
third-order intercept point (OIP3) using the following equation:

 (dB)

The input third-order intercept point (IIP3) is defined as 

IIP3 = (OIP3 – G), 

where G is the gain of the device. The IIP3 number quantifies the 
third-order linearity of a device. 

Use the IIP3 specification of the PXI-5660 RFSA as a guide to optimize 
its settings when measuring the IMD3 of an external device. 

The two tones injected into the UUT must be free from any third-order 
products. These two tones are combined, or summed, at or before the UUT 
input. If they are not well isolated, they intermodulate with each other and 
cause distortion. A signal combiner with good input-to-input isolation is 
recommended to minimize distortion of the input tones. 

Measurement Setup
A typical IMD3 measurement setup is shown in Figure 3-2. Lowpass filters 
are employed at the source outputs to suppress harmonics.

 

Figure 3-2.  Typical IMD3 Measurement Setup
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Understanding Two-Tone Third-Order Intermodulation 
Distortion Limits of the RFSA

The RFSA generates its own distortion spurs, which are capable of 
swamping the Po3 of the UUT and giving rise to an erroneous measurement. 
Too much power at the signal input of the RFSA may drive the system into 
a nonlinear region of operation and produce very large distortion products. 
Choosing an appropriate attenuation setting for the RFSA minimizes its 
IMD3 contribution to the measurement. The IMD3 improves by 2 dB for 
every 1 dB of input power decrement. 

To measure the IMD3 of a UUT, input power to the RFSA mixer must 
satisfy the following condition:

(dBm)

where IIP3rfsa is the input third-order intercept point of the RFSA (about 
10 dBm). For example, to accurately measure an IMD3 of 80 dBc the input 
power to the mixer must be less than –31.5 dBm. 

If the powers of two-tone signals are larger than this optimal level, they 
must be attenuated, either with the attenuators internal to the RFSA or with 
external attenuators. However, as attenuation raises the noise floor of the 
RFSA, there is a limit to how much attenuation can be used before noise 
overwhelms the distortion spurs. Its spurious-free dynamic range (SFDR) 
specification indicates the largest IMD3 value the RFSA can accurately 
measure, assuming 0 dB attenuation and input signals whose powers satisfy 
the above equation.

Choosing an Optimal Setting for the RFSA
Complete the following steps to set optimal attenuation levels for an IMD3 
measurement when the level of the third-order distortion spur (Po3) is 
unknown: 

1. Set the attenuation such that input power at the mixer is about 
–30 dBm. When using the RF Signal Analyzer Example VI, 
mixer level is the reference level minus attenuation.

2. Tune to the third-order distortion product frequency of interest, either 
or . Then decrease the resolution bandwidth until 

a distortion spur appears.

3. Increase the attenuation level.

Pmix IIP3rfsa
IMD3 3dB+

2
-------------------------------–≤

122 FF − 212 FF −
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4. If the harmonic spur decreases, repeat step 3. 

5. Repeat step 4 until the harmonic level does not decrease any further. 
Attenuation does not lower the distortion products of the signal; it only 
lowers the distortion products generated internally to the RFSA. 
Decrease the resolution bandwidth to lower the noise floor.

This setting is the optimal attenuation setting.

1 dB Gain Compression 
An amplifier maintains a constant gain for low-level input signals. 
However, at higher input levels, the amplifier goes into saturation and its 
gain decreases. The 1 dB compression point (P1dB) indicates the power 
level that causes the gain to drop by 1 dB from its small signal value. 

Measurement Setup
Measuring the 1 dB gain compression point of a device requires driving 
the UUT into compression without driving the PXI-5660 RFSA into 
compression. This requires proper attenuation at the RFSA and a 
signal source of sufficient power to compress the UUT. You may apply 
attenuation by programming the internal input attenuators or using 
external attenuation.

The 1 dB compression point is derived from the gain relationship between 
output power and input power. Using the measurement setup shown in 
Figure 3-3, source amplitude is slowly increased while the UUT output 
is monitored. Output power is plotted against input power as shown 
in Figure 3-4.

Figure 3-3.  Typical 1 dB Gain Compression Setup
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Figure 3-4.  Gain Compression Plot

The straight line on this graph is an extrapolation of the small signal gain 
of the UUT. The input 1 dB compression point is the input power that 
causes the UUT gain to drop by 1 dB from this small signal value, 
or approximately –12 dBm in this case.

Understanding RFSA Compression Limits 
Like all signal analysis devices, the PXI-5660 RF Signal Analyzer is not 
completely linear and will eventually reach compression. However, the 
RF Signal Analyzer architecture possesses a high degree of linearity, and 
the RFSA compression point is typically 5 dBm or higher. 

Ensure accurate UUT compression measurements by limiting the signal at 
the RFSA input mixer to 20 dB below the RFSA compression point listed 
in the Specifications for the PXI-5660 Signal Analyzer Note to Users. 

Choosing the Optimal RFSA Attenuation Setting
Choosing the optimal attenuation settings for a UUT compression 
measurement requires taking a couple of factors into account:

• The maximum output signal of your UUT must be attenuated to 
10–20 dB less than the compression point of the PXI-5660 RFSA. 
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• The resolution bandwidth setting of the RFSA must be low enough that 
small signals used to determine the linear gain of the UUT are not 
overwhelmed with noise from the RFSA. 

To set the proper RFSA attenuation level for a compression test on a UUT 
with known output compression estimate and known approximate gain, 
complete the following steps:

1. Set the RFSA mixer level to –20 dBm and its reference level to 10 dB 
above the estimated UUT compression point. When using the RF 
Signal Analyzer Example VI, mixer level is the reference level minus 
attenuation.

2. Set the RFSA center frequency to your intended testing frequency, 
its span to 1 MHz, and its resolution bandwidth to 1 kHz.

3. Inject a signal into the UUT small enough that its output level is at least 
20 dB below the estimated UUT compression point. If the UUT output 
signal level is too close to the noise floor of the RFSA, decrease the 
RFSA resolution bandwidth.

4. Increase the input signal to the UUT. If the output signal has reached 
5 dB below the RFSA reference level and compression of the UUT has 
not been reached, increase the reference level by 10 dB.

5. Repeat step 4 until compression appears in the UUT. 

You have now obtained the optimal attenuation setting for the RFSA.

Noise Figure
All devices have inherent noise. When noise is quantified, it is usually 
referred to the device input. In other words, all noise power a UUT inherits 
is assumed to come from its input. The noise figure of a UUT is the ratio 
in dB of its noise power to the noise power that a matched resistive load 
would deliver at room temperature. If you terminate a UUT input with a 
matched resistive load—typically 50 Ω—and measure the noise power 
density at its output (No), the noise figure (NF) is given by the following 
equation:

where G is the power gain of the UUT, k ≈ 1.38 × 10–23 is Boltzmann’s 
constant, and T0 ≈ 290 oK is the room temperature. 

NF 10
No G⁄
kT0

-------------- 
 log=



Chapter 3 Guidelines for Making Accurate Measurements

PXI-5660 RF Signal Analyzer User Manual 3-10 ni.com

If you use the PXI-5660 RF Signal Analyzer to measure the output noise of 
a UUT, the result of the measurement contains not only UUT noise but also 
noise intrinsic to the PXI-5660. If the UUT gain (G) is known, compute the 
noise figure of the UUT with the following equation:

(3-1)

where Nrfsa is the noise measured by the RFSA when its input is terminated 
with a matched resistive load and Nm is the measured noise with UUT 
attached. Both Nrfsa and Nm are given in watts; G is a linear power gain.

Measurement Setup
Figure 3-5 shows a typical noise figure measurement setup.

Figure 3-5.  Typical Noise Figure Measurement Setup

To measure the noise figure, perform the following steps:

1. Turn on the RFSA and let it warm up for 20 minutes.

2. Turn on the UUT if it is active.

3. Set the RFSA to the frequency of interest, and decrease the resolution 
bandwidth to about 1 kHz.

4. Terminate the RFSA input with a broadband resistive load.

5. Obtain an average reading of the noise level. Make sure to take enough 
readings to obtain a good average.
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6. Convert a reading taken in dBm to watts and normalize it to 1 Hz by 
dividing by the resolution bandwidth. This value is the noise floor of 
the RFSA at that frequency, which is Nrfsa in this guide.

7. Remove the load termination from the RFSA input.

8. Attach the output of the UUT to the RFSA input.

9. Input a known small signal into the UUT input. This signal level 
should be less then 10 dB below the 1 dB compression point of 
the UUT.

10. Measure the output signal level on the RFSA to determine the gain (G) 
of the UUT.

11. Remove the signal source and terminate the UUT input with a 
broadband resistive load.

12. Make another averaged reading of the noise with the UUT attached by 
repeating steps 5 and 6. This average is the noise value for the UUT 
and RFSA (Nm). 

13. Substitute your values into Equation 3-1 according to the following 
guidelines to determine the UUT noise figure:

• The value from step 6 equals Nrfsa

• The value from step 10 equals G

• The value from step 12 equals Nm
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4
Troubleshooting

This chapter provides help with common problems associated with 
installation, hardware, and taking measurements. Refer to Appendix A, 
Technical Support and Professional Services, for further assistance.

Configuration Problems 

RFSA Does Not Initialize
Failure to initialize may indicate a problem with MAX. Refer to the 
Configuring the Hardware Modules in MAX section in Chapter 1, Set Up 
and Configuration, for instructions on using MAX.

STATUS LED Does Not Light
If the RFSA is programmed via NI-TUNER to lock to an external reference 
source or to the PXI backplane, but the STATUS light does not indicate a 
phase locked status, check for the following errors:

• Make sure a cable is connected from the external source or the 
PXI 10 MHZ I/O connector to the FREQ REF IN connector 

• Ensure that the external source signal is large enough—typically 
greater than –10 dBm

If you programmed the PXI-5660 RFSA to use the PXI-5600 
downconverter module internal timebase, check for the following errors:

• If the RFSA measures the frequency incorrectly or shows no signal 
when one is supplied, one or more of the local oscillators is not 
phase-locked. If this happens, contact NI.

• If the RFSA measures the frequency correctly but the LED does not 
light, there could be a driver software error or the LED is damaged.
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The Digitizer Module Does Not Phase Lock 
to the Downconverter Module

If you programmed the PXI-5620 digitizer module to phase-lock to the 
PXI-5600 downconverter module internal reference and encounter failure, 
check that your cable is not faulty and that there is a reference signal 
coming out of the PXI-5600 10 MHZ OUT front panel connectors. If there 
is no signal at these outputs, contact NI.

If you programmed the PXI-5620 digitizer module to phase lock to the 
PXI backplane driven by the PXI-5600 downconverter module internal 
reference and encounter failure, make sure that the PXI 10 MHZ I/O 
connector is wired to one of the 10 MHz OUT connectors. Also ensure that 
the PXI-5600 is in slot 2 of the PXI chassis, immediately adjoining the 
PXI controller slot. 

Measurement Problems
For information about making signal distortion measurements, refer to 
Chapter 3, Guidelines for Making Accurate Measurements.

RFSA Amplitude Reading Does Not Match Source
If the RFSA reports an incorrect amplitude reading, check for the following 
possible errors:

• Check that the discrepancy between the RFSA and the source is within 
the error limits of the devices. Verify the absolute amplitude accuracy 
of the RFSA. Verify the output level accuracy for the source.

• Check for loss in the cables, which can be substantial. For example, 
RG58 coaxial cable loses about 2.1 dB of signal amplitude per foot at 
2 GHz. Unless you are using high-quality cables, expect losses when 
working with high-frequency signals.

• Ensure that you are using the amplitude calibration functions in the 
SMT. Failure to apply calibration functions results in large 
amplitude errors.
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RFSA Frequency Reading Does Not Match Source
If the RFSA reports an incorrect frequency reading, check for the following 
possible errors:

• Check that the RFSA is programmed to lock to the reference of the 
source.

• Ensure that the RFSA and the source are phase-locked. If the source 
and the RFSA modules are not phase-locked, then it is normal for a 
small frequency deviation to exist.

• Make sure the cable used to synchronize the source and RFSA by 
phase-locking is properly installed and is not faulty.

• Check that the PXI-5620 digitizer module is phase-locked to the 
PXI-5600 downconverter module, either through the front panel 
SMA connectors or the PXI backplane.
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5
Hardware Overview

This chapter is intended for advanced users and provides an overview of 
the PXI-5660 RFSA hardware, including brief explanations of hardware 
features and signal paths, and block diagrams of each module.

Features
The PXI-5660 RF Signal Analyzer consists of the PXI-5600 wideband 
downconverter module, and the PXI-5620 RF digitizer module.

PXI-5600 Wideband RF Downconverter Module
The PXI-5600 downconverter module, as shown in Figure 5-1, performs 
two primary functions: frequency shifting, or downconversion, and input 
signal conditioning. Frequency shifting is performed using a tunable 
oscillator in the superheterodyne signal chain. 

Input signal conditioning is accomplished using three stages of mixer 
conversion and two sets of gain attenuators whose levels are 
programmable. The first attenuator can be set to minimize distortion and 
other spurious signals when input levels are high and to minimize noise 
when input levels are low. Attenuator levels are set in software.

The second attenuator is in the second intermediate frequency (IF) path 
before the third mixer and ensures an appropriate output signal level even 
if the first mixer is intentionally driven into compression. These attenuators 
are also set when performing linearity measurements. For more 
information on proper attenuation levels, refer to Chapter 3, Guidelines for 
Making Accurate Measurements. 

The PXI-5600 downconverter module translates any 20 MHz-wide band 
of incoming signal to center at 15 MHz. Thus the downconverter module 
converts any block of spectrum, up to 20 MHz wide and centered anywhere 
between 9 kHz and 2.7 GHz, to an IF band between 5–25 MHz. This IF 
band is then passed to the PXI-5620 digitizer module, as shown in 
Figure 5-2, for further processing. 
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PXI-5620 IF Digitizer Module
The PXI-5620 is an IF high-speed digitizer module featuring a 14-bit 
analog-to-digital converter (ADC) with deep onboard sample memory. 
Offering sample rates of 1 kS to 64 MS/s and outstanding distortion-free 
performance, it has been designed to complement the PXI-5600 
downconverter module in FFT analysis applications.

Signal Paths 
A signal takes the following path through the RFSA to the PXI controller:

1. A signal enters the RFSA through the INPUT front panel connector of 
the PXI-5600 RF downconverter module. 

2. The PXI-5600 RF downconverter module “zooms in” on a 20 MHz 
block of spectrum and frequency-translates it to center around 
15 MHz. The translated IF signal is sent to the downconverter module 
OUTPUT connector. 

3. The IF signal is passed from the downconverter module OUTPUT 
connector to the PXI-5620 digitizer module front panel connector, 
INPUT.

4. The PXI-5620 filters and conditions the signal. Gain and dither 
are applied. 

5. The ADC converts the signal from analog to digital. 

6. The data is sent to onboard memory (the buffer). 

7. The data is transferred to your host computer. 

Block Diagrams
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Figure 5-1.  PXI-5600 RF Downconverter Module Block Diagram
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Figure 5-2.  PXI-5620 Digitizer Module Block Diagram

Calibration
Every National Instruments PXI-5660 RF Signal Analyzer is individually 
calibrated for frequency response at the factory. During frequency response 
calibration, the RFSA is used to measure a known high-precision signal. 
Any error in the returned data is quantified as a set of calibration constants 
used by software to calculate and apply correction to your analysis based 
upon the spectrum of interest. For more information on applying 
calibration correction, see the included example programs.

To guarantee specified accuracy, NI recommends returning both modules 
of your PXI-5660 RFSA to the factory for annual recalibration. The 
PXI-5600 and PXI 5620 modules are calibrated independently of one 
another, not as a combined system. At this time, recalibration of both 
modules can only be performed at NI. For more information on calibration, 
contact NI or visit ni.com/calibration.
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A
Technical Support and 
Professional Services

Visit the following sections of the National Instruments Web site at 
ni.com for technical support and professional services:

• Support—Online technical support resources include the following:

– Self-Help Resources—For immediate answers and solutions, 
visit our extensive library of technical support resources available 
in English, Japanese, and Spanish at ni.com/support. These 
resources are available for most products at no cost to registered 
users and include software drivers and updates, a KnowledgeBase, 
product manuals, step-by-step troubleshooting wizards, hardware 
schematics and conformity documentation, example code, 
tutorials and application notes, instrument drivers, discussion 
forums, a measurement glossary, and so on.

– Assisted Support Options—Contact NI engineers and other 
measurement and automation professionals by visiting ni.com/
ask. Our online system helps you define your question and 
connects you to the experts by phone, discussion forum, or email.

• Training—Visit ni.com/custed for self-paced tutorials, videos, and 
interactive CDs. You also can register for instructor-led, hands-on 
courses at locations around the world.

• System Integration—If you have time constraints, limited in-house 
technical resources, or other project challenges, NI Alliance Program 
members can help. To learn more, call your local NI office or visit 
ni.com/alliance.

If you searched ni.com and could not find the answers you need, contact 
your local office or NI corporate headquarters. Phone numbers for our 
worldwide offices are listed at the front of this manual. You also can visit 
the Worldwide Offices section of ni.com/niglobal to access the branch 
office Web sites, which provide up-to-date contact information, support 
phone numbers, email addresses, and current events.
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